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Read this manual carefully before you use this product and keep it handy for future reference.



Introduction

This manual describes basic instructions and notes about the use of this product. To get maximum ver-
satility all operators are requested to read this manual carefully and follow the instructions. Please keep
this manual handy for future reference.

Trademarks

Microsoft, Windows, PowerPoint and Windows Server are registered trademarks or trademarks of Mi-
crosoft Corporation in the United States and other countries.

Pentium is a registered trademark of Intel Corporation.

Apache is the trademark of The Apache Software Foundation.

Adobe, Acrobat and PostScript are trademarks of Adobe Systems Incorporated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The product names of the Windows operating systems are as follows:
» The product name of Windows® 98 is Microsoft® Windows® 98.
e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me).

* The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

e The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

e The product names of Windows Server ™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition
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How to Read This Manual

Symbols

In this manual, the following symbols are used :

ﬂlmportant
This symbol indicates a situation that may result in property damage or mal-

function if instructions are not followed. Be sure to read the instructions.

5] Preparation
This symbol indicates information or preparations required prior to operating.

& Note
This symbol indicates precautions for operation, or actions to take after abnor-
mal operation.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Elements on the machine's display panel or the computer's display, such as keys,
buttons, and menus.
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1. System Requirements

ScanRouter Web Navigator Conversion
Server System Requirements

? Limitation

O This product will not operate correctly if installed on the following environments:
¢ Computer used as a mail server or database
* Primary or backup domain controller
< Computer
PC/AT compatible
 CPU
Pentium III 1 GHz or faster (Pentium IV 2 GHz or faster recommended)

< RAM
512 MB or more (1 GB or more recommended)

« Hard Disk Space
300 MB minimum for installation

@ Note

O In addition to space for installation, separate hard disk space is required as
working space for document conversion. Amount of working space varies
depending on frequency of use, and data volume and type.

< Operating Systems
e Microsoft Windows 2000 Server + Service Pack 4 or later
e Microsoft Windows 2000 Advanced Server + Service Pack 4 or later
e Microsoft Windows Server 2003 Standard Edition
* Microsoft Windows Server 2003 Enterprise Edition

< Web Server

e Microsoft Internet Information Services 5.0 or later
e Apache HTTP Server 2.0 or later

& Note
O Microsoft Internet Information Services 5.0 can be installed from the CD-
ROM of Windows 2000 Server/ Advanced Server. Microsoft Internet Infor-

mation Services 6.0 can be installed from the CD-ROM of Windows Server
2003.

O Apache HTTP Server is automatically installed by selecting [Apache] in the
dialog box for selecting a Web server that appears during installation of
this system. 3



System Requirements

+ Network Protocol
TCP/IP

< Network Environment
e HTTP or HTTPS communication must be available on all networks.

¢ Name resolution through DNS must be available.

% Communication Port
To communicate using a Web server, the following TCP/IP ports must be
available:

e Port for HTTP
Required to set a port number when ScanRouter Web Navigator Conver-
sionOption is installed.

e Port for HTTPS
Required to set a port number when ScanRouter Web Navigator Conver-
sionOption is installed.

* Port for discovery
"50109" must be reserved.

iﬁklmportant
O To avoid port conflicts, select a port for ScanRouter Web Navigator Con-

versionOption that is not used by another Web server.

& Note

O If there is a firewall between server and clients, set it to make the TCP/IP
port available.

O If another ScanRouter System server product is already installed before
ScanRouter Web Navigator ConversionOption is installed and the settings
for Web server and port number are complete, you do not need to reserve
another TCP/IP port. Common Web server and TCP/IP port with another
ScanRouter System server product installed on the same computer are
used.
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2. Before Setup

ScanRouter Web Navigator is a Web application for searching, displaying, and
adding documents, working in cooperation with other ScanRouter System prod-
ucts such as ScanRouter DocumentServer and ScanRouter.

When ScanRouter Web Navigator ConversionOption is installed, added docu-
ments or local files in clients can be converted to image, PDF, text, or archive
files, etc.

Make the following preparations to install ScanRouter Web Navigator Conver-
sionOption, if necessary.

Preparing Web Server

To use Internet Information Services for the Web server, install it in advance.

& Note

O If you use Apache HTTP Server as the Web server, select [Apache] on the Web
server selection dialog box when you install ScanRouter Web Navigator Con-
versionOption. The Apache HTTP Server is set up automatically, and no
preparation is required here.

Installing Internet Information Services (lIS)

The following installation procedure is for Windows 2000. The procedure may
vary depending on the operating systems.

& Note
O If Internet Information Services (IIS) is installed during the installation of the
operating system, the following operation is not required.

ﬂ Log on to Windows with an administrator type account.

If you are logging in with another account, log off temporarily, and then log
on to Windows again with an administrator type account.

ﬂ On the [Start] menu, point to [Settings], and then click [Control Panel].
B Click [Add/Remove Programs] in Control Panel.

ﬂ Click [Add/Remove Windows Components]. The Windows Components wizard
appears.

B Select [Internet Information Services (lIS)], and then click [Next].

The installation starts.

E After a message about completion appears, click [Finish].
Now, the installation of Internet Information Services (IIS) is completed.
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3. ScanRouter Web Navigator
ConversionOption Setup

Installing ScanRouter Web Navigator

ConversionOption

Install ScanRouter Web Navigator
ConversionOption from the CD-
ROM on the computer to be used as
the conversion server.

& Note

O Log on to Windows using an ac-
count that has Administrator ac-
cess rights, and then perform
installation. If you are logged on
under a different type of account,
log off, and then log on again using
an account that has Administrator
access rights.

ﬂ Stop the Web server on the com-
puter where installation is to take
place.

@ Note

O For how to stop the Web server,
see Windows Help.

g Insert the CD-ROM containing
this product into the CD-ROM
drive.

The [ScanRouter Web Navigator Con-
versionOption Setup] dialog box ap-
pears.

B Click [ScanRouter Web Navigator
ConversionOption].
A confirmation message about
starting the installation appears.
O click [ves].

B Click [Next] in the displayed dia-
log box.

B Confirm the Software License
Agreement, and then click [Yes].

nEnter the user information, and
then click [Next].

Enter the user name, company
name, and product key.

B Specify the installation destina-
tion, and then click [Next].

@ Note

O If there is a ScanRouter System
product already installed, the
installation path confirmation
dialog box appears. The instal-
lation destination will be a fold-
er common to them. Therefore,
the destination cannot be speci-
fied.

O The following destinations can-
not be specified:

e destinations in Windows fold-
ers

e destinations in the root direc-
tory

e destinations within remov-
able media

O If another ScanRouter System
server product is already in-
stalled before ScanRouter Web
Navigator ConversionOption is
installed and the settings for
Web server and port number
are complete, you do not need
to perform steps BMll. Proceed to
steplll. Common Web server and
port number with another Scan-
Router System server product
installed on the same computer
are used.



ScanRouter Web Navigator ConversionOption Setup

ﬂ Select the Web server to use, and
then click [Next].

@ Note

O To specify Internet Information
Services as the Web server, In-
ternet Information Services
must be already installed in the
computer where ScanRouter
Web Navigator ConversionOp-
tion is to be installed. See p.5
“Preparing Web Server”.

3 When [Apache] is selected as the
Web server, Apache HTTP
Server is also installed with
ScanRouter Web Navigator
ConversionOption.

O To make the Web server sup-
port SSL, make the SSL commu-
nication settings after ScanRouter
Web Navigator ConversionOp-
tion is installed. For SSL com-
munication settings, see p.17
“SSL Settings”.

[m Specify the Web server port num-
ber to use, and then click [Next].

Specify the HTTP and HTTPS port
numbers.

ﬂlmportant

O The HTTP and HTTPS port num-
bers cannot be changed once it
is set.

O If a Web server other than Inter-
net Information Services is al-
ready installed, do not specify
the port number used for that
Web server.

m Confirm the settings.

Click [Next] to start installing Scan-
Router Web Navigator Conver-
sionOption.

& Note

O During installation, the [Digital
Signature Not Found] dialog box
which indicates a message
about adding a printer driver
for RICOH File Writer V3 ap-
pears. Click [Yes].

B Click [Finish] in the installation

completion dialog box.

[B Click [Exit Setup] in the [ScanRouter

Web Navigator ConversionOption Set-
up] dialog box.

The message that prompts you to
restart the computer is displayed.

@ click [oK].

The computer restarts.

Log on to Windows again with the
account used when ScanRouter
Web Navigator ConversionOption
was installed.

The [Authorization for Server Access]
dialog box appears.

& Note

O You must restart the server to
enable new settings. Otherwise,
ScanRouter Web Navigator
ConversionOption does not op-
erate correctly.

O If the conversion option is in-
stalled on the same server as
ScanRouter Web Navigator, the
[Authorization for Server Access]
dialog box does not appear. In-
stallation is complete.

[BMake the necessary authentica-

tion settings.

@ In the [Password] and [Confirm
Password] boxes, enter the user
password used when Scan-
Router Web Navigator Conver-
sionOption was installed.



Installing ScanRouter Web Navigator ConversionOption

@ Click [OK].

The Windows settings required
to operate ScanRouter Web
Navigator ConversionOption
change automatically.

M click [Finish] in the installation
completion dialog box.

m Restart the computer.

Make any other necessary settings
required for ScanRouter Web Nav-
igator ConversionOption.

p Reference

p-11 “Necessary Information for
PDF Conversion”

p-17 “SSL Settings”
p-21 “Related Application Set-
upll
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Uninstalling ScanRouter Web Navigator
ConversionOption

This section describes uninstalling ScanRouter Web Navigator ConversionOp-
tion.

ﬂ Stop the Web server.

& Note
O For how to stop the Web server, see Windows Help.

g Click [Add/Remove Programs] in Control Panel.
The [Add/Remove Programs] dialog box appears.

B Click [ScanRouter Web Navigator ConversionOption], and then click [Change/Re-
move].
The dialog box appears for changing, modifying, and deleting ScanRouter
Web Navigator ConversionOption.

O Click [Delete], and then click [Next].
Follow the instructions in the dialog box to perform the uninstallation.



Necessary Information for PDF Conversion

Necessary Information for PDF Conversion

PDF conversion using ScanRouter
Web Navigator ConversionOption
requires installing Adobe Acrobat
Distiller Server 5.0 or Adobe Acrobat
Distiller Server 6.0 on the conversion
server computer, and making the nec-
essary settings.

Installing and Setting Adobe
Acrobat Distiller Server 5.0

/O Reference

When using Adobe Acrobat Dis-
tiller Server 6.0, see p.13 “Installing
and Setting Adobe Acrobat Distill-
er Server 6.0”.

Installing Adobe Acrobat Distiller Server
5.0

@ Note

O When installing Adobe Acrobat
Distiller Server 5.0, be sure to log
on to Windows with the account
used when ScanRouter Web Navi-
gator ConversionOption was in-
stalled.

Start the setup program from the CD-
ROM of Adobe Acrobat Distiller
Server 5.0, and install Adobe Acrobat
Distiller 5.05 by following the instruc-
tions in the dialog box.

The setup program is in the following
location on the CD-ROM. Execute it
from My Computer or Windows Ex-
plorer.

* %CD-ROM%\Windows\En-
glish\Installer\Setup.exe

Make the following settings in the di-

alog box displayed during installa-

tion.

¢ In the dialog box for selecting the
setup method:
Select [Typical] as the setup meth-
od.

Setting Acrobat Distiller 5.0

n Start Acrobat Distiller 5.0.

The font table is created at first
startup only.

ﬂ For automatic PDF conversion,
make the necessary settings for
watched folders.

@ Create a folder to use as the
watched folder.

Create the folder "PDF-IO" in
the following location from My
Computer or Windows Explor-
er:

e "X:\Program Files\ Adobe\
Acrobat 5.0"

@ On the [Settings] menu, click
[Watched Folders].

The [Acrobat Distiller - Watched
Folders] dialog box appears.

@ Click [Add].

The [Browse for Folder] dialog
box appears.

O Select the monitor folder
(X:\Program Files\Adobe\Ac-
robat 5.0\PDF-I0O) created in
step @), and then click [OK].

The selected watched folder is
added to the list on the [Acrobat
Distiller - Watched Folders] dialog
box.

@ Click [OK] to close the [Acrobat
Distiller - Watched Folders] dialog
box.

11




12

ScanRouter Web Navigator ConversionOption Setup

E) On the [Settings] menu, click [Job
Options], click the [Fonts] tab, and
then click [Ignore] in [When Embed-
ding Fails].

ﬂ Click [Save As].

B 1 the [Save Job Option As] dialog
box, enter "RDSP_Optimized" to
[File name], and then click [Save].

E Quit Acrobat Distiller 5.0.

Setting Acrobat Distiller Printer Driver

The following procedure is for Win-
dows 2000. Procedures may differ de-
pending on the operating system.

ﬂ On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

ﬂ Right-click the Acrobat Distiller
icon, and then click [Printing Prefer-
ences] on the displayed menu.

B Click the [Adobe PDF Settings] tab
in the [Acrobat Distiller Printing Pref-
erences] dialog box.

Check the job option is specified as
"RDSP_Optimized". If it is not, se-
lect [RDSP_Optimized] in the list.

ﬂ Clear all the check boxes follow-
ing [Do not send fonts to Distiller],
and then click [OK].

Installing Adobe PostScript Printer
Driver

ﬂ Open the CD-ROM from My Com-
puter or Windows Explorer, and
then open "% CD-ROM% \Win-
dows\English\Utilities\Driv-
ers\WinlInstaller1.0.4\setup.exe".

B Click [Next] in the [Welcome] dia-
log box. In the [End User License
Agreement] dialog box, click [Ac-
cept].

B In the [Printer Connection Type] dia-
log box, click [lt is directly connected
to your computer (Local Printer)], and
then click [Next].

ﬂ Click [Next] in the [Local Port Selec-
tion] dialog box.

& Note

O Settings in this dialog box must
be changed after the Adobe
PostScript printer driver is in-
stalled. Click [LPT1: Local Port]
temporarily.

B Click [Browse] in the [Select Printer
Model] dialog box.

E In the [Browse for Printer] dialog
box, select [Acrobat Distiller] on the
[Printers] list, and then click [OK].

& Note
O Acrobat Distiller is in "X:\Pro-

gram Files\ Adobe\Acrobat
5.0\ Distillr\ Xtras".

B in the [Select Printer Model] dialog
box, check [Acrobat Distiller] is se-
lected, and then click [Next].

B in the [Sharing] dialog box, click
[Not shared], and then click [Next].

g In the [Printer Information] dialog
box, check the printer name is
"Acrobat Distiller". Select [Yes] in
[Do you want to use this printer as your
default printer?], select [No] in
[Would you like to print the test page?],
and then click [Next].

[E] Click [Install] in the [Setup Informa-
tion] dialog box.



Necessary Information for PDF Conversion

[I] In the [Printer Configuration] dialog
box, select [No] in [Would you like to
configure your printer now?], and
then click [Next].

iECheck the message "Setup has
finished copying files to your
computer." appears, and then
click [Finish].

Setting Adobe PostScript Printer Driver

The following procedure is for Win-
dows 2000. Procedures may differ de-
pending on the operating system.

ﬂ On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

B Righi-click the [Acrobat Distiller] icon,
and then click [Properties] on the dis-
played menu.

Bln the [Acrobat Distiller Properties]
dialog box, click the [Ports] tab,
and then add a new port.

@ Click [Add Port].

The [Printer Ports] dialog box ap-
pears.

@ Select [Local Port] in [Available
port types], and then click [New
Port].

The [Port Name] dialog box ap-
pears.

© Enter "X:\Program Files\ Adobe\
Acrobat 5.0\PDF-IO\in\new-
PDF.ps" as the port name, and
then click [OK].

The [Printer Ports] dialog box re-
appears.

& Note

O The port name "X" will be the
hard disk drive where Acro-
bat Distiller Server is in-
stalled.

O Click [Cancel] to close the [Print-
er Ports] dialog box.

B 0n the [Ports] tab in the [Acrobat
Distiller Properties] dialog box,
check the added port is selected
and "Acrobat Distiller" is set in
[Printer], and then click [Apply].

B click [ok.

Installing and Setting Adobe
Acrobat Distiller Server 6.0

/O Reference

When using Adobe Acrobat Dis-
tiller Server 5.0, see p.11 “Installing
and Setting Adobe Acrobat Distill-
er Server 5.0”.

Installing Adobe PostScript Printer
Driver

ﬂ On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

Fd Double-click the Add Printer icon.
Add Printer Wizard starts.

B ik pNext).

The [Local or Network Printer] dialog
box appears.

ﬂ Select [Local Printer] to clear the
[Automatically detect and install my
Plug and Play printer] check box, and
then click [Next].

The [Select the Printer Port] dialog
box appears.

B Select [Create a new port], select [Lo-
cal Port] in [Type], and then click
[Next].

The [Port Name] dialog box appears.

13
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B Create the destination folder for
the PS files.

@ Create the folder "Adobe" in
the following location from
My Computer or Windows Ex-
plorer.

e "X:\Program Files"

@ Create the folder "PSout" in the
folder created in @.

B 1n the [Port Name] dialog box dis-
played in step B, enter the folder
hierarchy created in step @ and
"\new.ps".

e X:\Program Files\ Adobe\PSout
\new.ps

B crick fox).
The [Add Printer Wizard] dialog box

reappears.

ﬂ Select [Ricoh] in [Manufacturers], se-
lect [Ricoh PC Laser 6000-PS v50.5] in
[Printers], and then click [Next].

) Check [Ricoh PC Laser 6000-PS v50.5]
is selected in [Printer name], and
then click [Next].

[I] Select [Do not share this printer], and
then click [Next].

[E Select [Yes] in [Do you want to print a
test page?], and then click [Next].

B click [Finish].
@ click [oK].

[B Check "new.ps'" has been output
in the folder created in step @.

& Note

O If "new.ps" is not output, repeat
the procedure from step .

Setting Adobe PostScript Printer Driver

The following procedure is for Win-
dows 2000. Procedures may differ de-
pending on the operating system.

n On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

B Right-click [Ricoh PC Laser 6000-PS
v50.5], and then click [Properties]
on the displayed menu.

E) in the [Ricoh PC Laser 6000-PS v50.5
Properties] dialog box, click the
[Advanced] tab, select [Print directly
to the printer], and then click [Ap-

ply].
O click [0K].

Installing Adobe Acrobat Distiller Server
6.0

&P Note

O When installing Adobe Acrobat
Distiller Server 6.0, be sure to log
on to Windows with the account
used when ScanRouter Web Navi-
gator ConversionOption was in-
stalled.

Start the setup program from the CD-
ROM of Adobe Acrobat Distiller
Server 6.0, and install Adobe Acrobat
Distiller 6.0 following the instructions
in the dialog box.

The setup program is in the following
location on the CD-ROM. Start it from
My Computer or Windows Explorer.

* %CD-ROM%\Windows\En-
glish\Installer\Setup.exe
Make the following settings in the di-

alog box displayed during installa-
tion.



Necessary Information for PDF Conversion

* On the page for selecting the setup
method:
Select [Typical] as the setup meth-
od.

* On the page showing the installa-
tion destination folder:
Be sure to confirm the installation
destination.

Setting Acrobat Distiller Server 6.0

ﬂ Start Acrobat Distiller Server 6.0.

The font table is created at first
startup only.

g On the [File] menu, click [Prefer-
ences].

The [Preferences - Acrobat Distiller]
dialog box appears.

B Clear the [View PDF when using Dis-
tiller] and [Delete Log Files for suc-
cessful jobs] check boxes, and then
click [OK].

B On the [Settings] menu, click [Edit
Adobe PDF Settings].

The [Adobe PDF Settings] dialog box
appears.

B Select the [General] tab, and then
make the following settings in
[File Options]:

e [Compatibility]
Select [Acrobat 5.0 (PDF 1.4)].

e [Embed thumbnails]
Select the check box.

[3 On the [Fonts] tab, click [ignore] in
[When embedding fails], and then
click [OK].

[ in the [Save Adobe PDF Settings As]

dialog box, enter "RDSP_Optimized"
under [File name], and then click
[Save].
Check "RDSP_Optimized" is se-
lected, which was created in [De-
fault Settings] in the [Acrobat Distiller]
dialog box.

E Quit Acrobat Distiller 6.0.

Setting Acrobat Distiller Printer Driver

The following procedure is for Win-
dows 2000. Procedures may differ de-
pending on the operating system.

ﬂ On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

B Right-click the Adobe PDF icon,
and then click [Printing Preferences]
on the displayed menu.

E) Click the [Adobe PDF Settings] tab
in the [Adobe PDF Printing Preferenc-
es] dialog box.

Make the following settings:

e [Default Settings] in [Adobe PDF
Conversion Settings]
Select [RDSP_Optimized].

e [Do not send fonts to "Adobe PDF"]
Select the check box. Clear all
other check.

O ciick [Apply].

B Create the destination folder for
the PDF files.

Create the folder "PDF_Output" in
the following location from My
Computer or Windows Explorer.

¢ "X:\Program Files\ Adobe\Ac-
robat 6.0"

15
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B On the [Start] menu, point to [Set-
tings], and then click [Printers].

The [Printers] dialog box appears.

ﬂ Right-click the Adobe PDF icon,
and then click [Properties] on the
displayed menu.

B In the [Adobe PDF Properties] dialog
box, select the [Ports] tab, and then
add a new port.

@ Click [Add Port].

The [Printer Ports] dialog box ap-
pears.

@ Select [Adobe PDF Port] in [Avail-
able port types], and then click
[New Port].

The [Browse for Folder] dialog
box appears.

© Select the folder created in step
B, and then click [OK].

O Click [Cancel] to close the [Print-
er Ports] dialog box.

The [Adobe PDF Properties] dia-
log box reappears.

B click [Appiy].

[mSelect the [Advanced] tab, select
[Print directly to the printer], and then
click [Apply].

@ click [oK.
The [Printers] dialog box reappears.
iERight-click the Adobe PDF icon
again, and then select [Set as De-

fault Printer] on the displayed
menu.



SSL Settings

SSL Settings

To make a Web server SSL compati-
ble and use SSL for communication
among servers such as ScanRouter
Web Navigator, ScanRouter EX, and
ScanRouter DocumentServer, or be-
tween ScanRouter Web Navigator
and clients (Web browser), you can
use the SSL setting tool to make the
following settings:

@ Note

O The SSL setting tool is installed
only when one of the following
software systems is installed:

* ScanRouter Web Navigator

* Document Management Con-
nection Program (Packaged
with ScanRouter Web Naviga-
tor)

* Deliver Connection Program
(Packaged with ScanRouter
Web Navigator)

* ScanRouter Web Navigator Con-
versionOption

e ScanRouter DocumentServer
(Ver.2.xxx or later)

e ScanRouter EX Professional
¢ ScanRouter EX Enterprise

O When the communication with
SSL is used between a client com-
puter and a server, SSL settings on
the server are required as de-
scribed below. Also, SSL settings
on the client computer connected
to that server are required. For de-
tails about SSL settings on the cli-
ent computer, see the Readme file.

O When you use "Internet Informa-
tion Services" as the Web server
and communicate with SSL, there
are some necessary settings after
importing the certificate by per-
forming the operation below. For
details about the settings, see the
Readme file.

O When importing certificate or
changing SSL settings, be sure to
restart the computer after all set-
tings are complete.

Setting CA Server

A CA server is a server used to issue
an electronic certificate that permits to
perform SSL communication. Any
computer where the SSL setting tool is
installed can be used as a CA server.

Before making SSL settings, you need
to configure a server as a CA server.
SSL communication among servers
can be enabled provided that the oth-
er servers have imported the certifi-
cate.

Issuing Certificate

A CA server is used to issue a certifi-
cate. A certificate specific to each
server that attends SSL communica-
tion is issued.

Certificates for a CA server and an-
other server (for one unit) are issued
at first issue. If you want more than
one unit of other servers to utilize SSL
communication, separately issue an-
other certificate following the proce-
dure described in p.19 “Issuing
certificates (at second issue or later)”.

After a certificate specific to each
server is issued, it can be imported to
an appropriate server.

17
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Issuing certificates (at first issue)

At first issue of certificates from the
SSL setting tool, certificates for a CA
server and another server (for one
unit) are issued.

& Note

O At second issue or later, only the
certificate for SSL communication
server is issued.

ﬂ On the [Start] menu, point to [Pro-
grams], point to [ScanRouter Sys-
tem], and then click [SSL Settings].

The dialog box to select options of
SSL settings appears.

gClick [Issue Certificate], and then
click [Next].

The [Create CA Server Certificate 1/3]
dialog box appears.

B Enter area information. Enter the
country, area, and city, and then
click [Next].

& Note

3 [Country:] should be filled in
with single-byte 2 character
strings.

ﬂ Enter company information. En-
ter the company name and organi-
zation name, and then click [Next].

B Enter network information. Enter
the server name and e-mail ad-
dress, and then click [Next].

e Server Name:
Enter a server name at random.

* Email Address:
Enter an e-mail address. It ap-
pears when the certificate is dis-
played in a Web browser.

The [Create Server Certificate 1/3] dia-
log box appears.

E Enter area information. Enter the
country, area, and city, and then
click [Next].

& Note

3 [Country:] should be filled in
with single-byte 2 character
strings.

ﬂ Enter company information. En-
ter the company name and organi-
zation name, and then click [Next].

B Enter network information. Enter
the server name and e-mail ad-
dress, and then click [Next].

* Server Name:
Enter a server name that will
import the server name certifi-
cate in the format of a host name
with a domain name. (e.g.,
www.rds.co.jp)

* Email Address:
Enter an e-mail address. It ap-
pears when the certificate is dis-
played in a Web browser.

g Enter a folder name to which the
certificate for another server is

placed, and then click [Next].

mln the confirmation dialog box,
click [OK].

The certificate is placed in the spec-
ified folder.

& Note

O The file name "server.pl2" is
given to all certificates for other
servers.



SSL Settings

Issuing certificates (at second issue or
later)

Certificates for other SSL. communica-
tion servers are issued when certifi-
cates are issued from the SSL setting
tool for the second time or later.

ﬂ On the [Start] menu, point to [Pro-
gram], point to [ScanRouter System],
and then click [SSL Settings].

The dialog box to select options of
SSL settings appears.

gClick [Issue Certificate], and then
click [Next].

The [Create Server Certificate 1/3] dia-
log box appears.

B Enter area information. Enter the
country, area, and city, and then

click [Next].

& Note

3 [Country:] should be filled in
with single-byte 2 character
strings.

ﬂ Enter company information. En-
ter the company name and organi-
zation name, and then click [Next].

B Enter network information. Enter
the server name and e-mail ad-
dress, and then click [Next].

e Server Name:
Enter a server name that will
import the server name certifi-
cate in the format of a host name
with a domain name. (e.g.,
www.rds.co.jp)

* Email Address:
Enter an e-mail address. It ap-
pears when the certificate is dis-
played in a Web browser.

BSpecify the folder to which the
certificate is placed, and then
click [Next].

nln the confirmation dialog box,
click [OK].

The certificate is placed in the spec-
ified folder.

& Note

O The file name "server.pl2" is
given to all certificates for other
servers.

Importing Certificate

A certificate issued from the CA serv-
er is imported to each server. Every
server, including the CA server,
which performs SSL communication
should import its own certificate.

l] On the [Start] menu, point to [Pro-
gram], point to [ScanRouter System],
and then click [SSL Settings].

The dialog box to select options of
SSL settings appears.

B Click [import Certificate], and then
click[Next].

The dialog box to select an appro-
priate certificate appears.

B Specify the folder in which a cer-
tificate for another server (serv-
er.p12) is placed, and then click

[OK].

ﬂln the confirmation dialog box,
click [OK].
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Changing SSL Settings

You can make settings for SSL com-
munication. This procedure is needed
when a practical operation of SSL
communication is started or changed.

You can make settings for every serv-
er, including the CA server, which
performs SSL communication.

ﬂ On the [Start] menu, point to [Pro-
gram], point to [ScanRouter System],
and then click [SSL Settings].

The dialog box to select options of
SSL settings appears.

B Click [Change SSL method], and
then click [Next].

e All SSL Connections

SSL is used for all communica-
tions including those between
ScanRouter Web Navigator and
a Web browser, and between
the currently used server and
other ScanRouter Document-
Servers.

e Use SSL between Web Browser
and Server Connections
SSL is used only for the commu-
nication between ScanRouter
Web Navigator and a Web
browser.

* Do not use SSL
You can quit operations of SSL
on the server currently in use.

& Note

O If you quit operations of SSL
at this point, you will not be
able to communicate with a
server that uses SSL. Make
changes to the SSL settings of
related servers, as needed.

Bln the confirmation dialog box,
click [OK].



4. Appendix

Related Application Setup

Document conversion using Scan-
Router Web Navigator Conversion-
Option requires installing the
application used to create the data to
be converted on the conversion serv-
er, and making the necessary settings.

ﬂlmportant

O When installing the related appli-
cation, be sure to log on to Win-
dows with the account used when
ScanRouter Web Navigator Con-
versionOption was installed.

O Before starting conversion, be sure
to start each installed application,
and then check the function oper-
ates correctly. Set application dialog
boxes not to display automatically.

& Note

O If an application used to create the
target data is not installed on the
conversion server, documents may
not be converted.

Microsoft Office 2000

Insert the CD-ROM of Microsoft Of-
fice 2000. The setup dialog box auto-
matically appears. According to the
instructions on the dialog box, install
each application.

The hard disk must have sufficient
free space. Make the necessary set-
tings not to install unused applica-
tions as much as possible.

& Note

O From among the Office2000 func-
tions, the [Office Tools] and [Con-
verter and Filter] functions are
recommended to be installed with
all the subcomponents.

Setting Word 2000

n Start Word 2000.

ﬂ After the "Welcome to Microsoft
Word!" message appears, click
[Use Microsoft Word Now].

& Note

O If the [Office2000 Registration Wiz-
ard] dialog box appears, click
[No]. For the user registration,
perform it later as required.

B Quit Word 2000.

Setting Excel 2000

n Start Excel 2000.

ﬂ After the "Welcome to Microsoft
Excel!" message appears, click
[Use Microsoft Excel Now].

@ Note

O If the [Office2000 Registration Wiz-
ard] dialog box appears, click
[No]. For the user registration,
perform it later as required.

B Quit Excel 2000.

Setting PowerPoint 2000

n Start PowerPoint 2000.

ﬂ After the "Welcome to Microsoft
PowerPoint!" message appears,
click [Use Microsoft PowerPoint Now].
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& Note

O If the [Office2000 Registration Wiz-
ard] dialog box appears, click
[No]. For the user registration,
perform it later as required.

B On the [Create New Presentation] di-
alog box, click [Cancel].

ﬂOn the [Tools] menu, click [Op-
tions].

B 1n [view Settings] in the [View] tab,
clear the check boxes of [Startup Di-
alog] and [New Slide Dialog], and
then click [OK].

E Quit PowerPoint2000.

Restart PowerPoint2000, and then
confirm that the [Create New Presen-
tation] and [New Slide] dialog boxes
do not appear.

Microsoft Office XP

Insert the CD-ROM of Microsoft Of-
fice XP. The setup dialog box auto-
matically appears. According to the
instructions on the dialog box, install
each application.

The hard disk must have sufficient
free space. Make the necessary set-
tings not to install unused applica-
tions as much as possible.

When installing Office XP, make the
necessary settings as follows:

* Dialog box to select the installation
type
Click [Custom] in Installation Type
Selection.

¢ Dialog box to select the application
to be installed
Click [Install by Selecting Options for
Each Application].

¢ Dialog box to select the option to
be installed
On [Office Common Functions], point
to [Extend Input System], and then
set [IME] not to be installed.

& Note

O If IME included in Office XP is
installed, creating PDF of the
Office applications may fail.

Setting Word/Excel/PowerPoint 2002

When using Microsoft Office XP, be
sure to undergo authentication.

Unless you undergo the authentica-
tion, note that the functions such as
printing and creating PDF do not op-
erate correctly.

ﬂ Start Word/Excel/PowerPoint 2002.

ﬂ Through the Microsoft Office XP
license authentication wizard,
undergo the authentication ac-
cording to the displayed messag-
es.

& Note
O If the license authentication
wizard does not appear, the au-

thentication is already complet-
ed.

B Quit Word/Excel/PowerPoint 2002.



Related Application Setup

Microsoft Office 2003

Insert the CD-ROM of Microsoft Of-
fice 2003. The setup dialog box auto-
matically appears. Follow the
instructions in the dialog box to in-
stall each application.

The hard disk must have sufficient
free space. Uninstall any unnecessary
applications.

Setting Word/Excel/PowerPoint 2003

ﬂ Start Word/Excel/PowerPoint 2003.

Bdin [Macro] on the [Tools] menu,
click [Security]

B Check that the security level is set
to [High], and then click [OK].

ﬂ Quit Word/Excel/PowerPoint 2003.
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Some of illustrations or explanations in this guide may differ from your product due to improvements or
changes in the product.

Note

. The contents of this document are subject to change without notice.
. THE SUPPLIER SHALL NOT BE LIABLE FOR THE RESULTS OF OPERATING THIS PRODUCT

(HARDWARE, SOFTWARE) OR USING THIS DOCUMENT.

No part of this document may be duplicated, replicated, reproduced in any form, modified or quoted
without prior consent of the supplier.

ﬂlmportant

)

It is possible that any document or data stored in the PC will be damaged or lost by user error during
operation or software error. Be sure to back up of all important data beforehand. Important docu-
ments and data should always be copied or backed up. Documents and data can be lost because
of malfunction or human error. Furthermore, the customer is responsible for protection measures
against computer viruses, worms, and other harmful software.

Do not remove or insert any disk while operating this software.

THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR DAMAGES OR LOSS OF ANY DOCU-
MENT OR DATA PRODUCED BY USING THIS SOFTWARE.

THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL
OR INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION, AND THE
LIKE) CAUSED BY FAILURE OF THIS SOFTWARE OR LOSS OF DOCUMENTS OR DATA, NOR
FOR ANY OTHER DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, IF THE SUP-
PLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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